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BAB II 

TINJAUAN PUSTAKA 

2.1 Sejarah PLC 

Sebelum PLC diciptakan, sistem kontrol yang digunakan untuk membantu 

kegiatan produksi di industri-industri pada masa itu masih berbasis relay logic. 

Sistem berbasis relay logic menggunakan relay untuk melakukan kegiatan 

pengendalian system. Namun, sayangnya penggunaan relay ini tidak terlalu 

memuaskan karena kurang fleksibel terhadap perubahan dalam sistem. Apabila 

suatu pabrik ingin meningkatkan kapasitas produksinya, maka sistem kontrol yang 

mengendalikan kegiatan produksi di pabrik tersebut juga harus dirubah. 

Dalam sistem kendali berbasis relay logic, perubahan tersebut 

membutuhkan biaya yang besar dan sangat melelahkan. Selain itu sistem berbasis 

relay logic juga menyita ruang yang banyak dan biaya pemeliharaannya juga 

sangat besar. 

The Hydramatic Division pada General Motors Corporation lah yang 

pertama kali menspesifikasikan kriteria-kriteria untuk Programmable Logic 

Controller (PLC) yang pertama pada tahun 1968. Tujuan mereka saat itu adalah 

untuk menggantikan sistem kontrol berbasis relay yang mereka gunakan karena 

tidak fleksibel dan memakan biaya yang sangat besar. 

Untuk itu, mereka mengumumkan untuk menerima proposal yang sanggup 

untuk menggantikan sistem kontrol relay mereka dengan suatu perangkat 

elektronik yang handal dengan spesifikasi – spesifikasi sebagai berikut: 

1. Sistem kontrol yang baru tersebut harus mempunyai harga yang bersaing 

dengan sistem kontrol berbasis relay yang digunakan saat itu. 

2. Sistem tersebut harus tahan terhadap kondisi lingkungan industri yang berat. 

3. Antarmuka input dan output harus mudah untuk diganti-diganti. 

http://ndoware.com/apa-itu-plc.html
http://ndoware.com/apa-itu-plc.html
http://ndoware.com/apa-itu-plc.html
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4. Controller harus didesain dalam bentuk modul-modul sehingga bagian-

bagian tertentu dapat dilepas sewaktu-waktu untuk penggantian atau 

perbaikan. 

5. Sistem kontrol mempunyai kemampuan untuk mengumpulkan data dan 

mengirimkannya ke central system. 

6. Sistem kontrol tersebut harus dapat digunakan lagi untuk kondisi yang 

berbeda. 

7. Metode untuk memprogram controller harus sederhana sehingga mudah 

dipahami oleh karyawan pabrik. 

Proposal yang menang dan memenuhi spesifikasi yang diinginkan oleh 

Hydramatic Division adalah proposal yang dimenangkan oleh Bedford Associates. 

Dick Morley salah satu anggota tim dari Bedford Associates yang memenangkan 

proposal tersebut dianggap sebagai “bapak” dari PLC. PLC pertama yang 

diciptakan oleh Bedford Associates tersebut memenuhi semua kriteria yang 

diinginkan oleh Hydramatic Division. 

Dalam waktu singkat penggunaan PLC mulai menyebar ke industri-

industri lain. Pada tahun 1971, PLC mulai digunakan untuk menggantikan relay 

pada industri-industri seperti: industri makanan dan minuman, industri 

pengolahan metal, industri manufaktur, dan industri pulp dan kertas. 

Kesuksesan PLC ini dikarenakan kemampuannya yang merupakan sebuah 

peningkatan signifikan dari sistem kontrol berbasis relay karena lebih mudah 

digunakan, membutuhkan ruang dan energi yang lebih sedikit, mempunyai 

indikator-indikator untuk mendiagnosis sehingga lebih memudahkan 

troubleshooting apabila terjadi masalah, dan dapat digunakan lagi untuk proyek 

yang lain apabila proyek yang sedang berjalan dihentikan. 

Kemampuan PLC terus dikembangkan hingga sekarang. PLC saat ini 

mempunyai scan times yang lebih cepat karena menggunakan teknologi 

mikroprosesor yang lebih maju. Kemampuan input-output nya juga meningkat 

http://en.wikipedia.org/wiki/Dick_Morley
http://ndoware.com/apa-itu-plc.html
http://ndoware.com/mikrokontrolerdanmikroprosesor.html
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menjadi lebih hemat ruang dan berbiaya lebih rendah. Walaupun kemampuan 

PLC terus meningkat sehingga mempunyai scan times yang lebih cepat, tipe-tipe 

antarmuka yang lebih bervariasi, kemampuan memproses data yang lebih canggih, 

namun spesifikasi PLC tetap mempertahankan tujuan awal penciptanya, yaitu 

mudah untuk digunakan dan dipelihara. 

2.2 Pengertian PLC 

Secara mendasar PLC adalah suatu peralatan kontrol yang dapat 

diprogram untuk mengontrol proses atau operasi mesin. Kontrol program dari 

PLC adalah menganalisa sinyal input kemudian mengatur keadaan output sesuai 

dengan keinginan pemakai. Keadaan input PLC digunakan dan disimpan didalam 

memory dimana PLC melakukan instruksi logika yang di program pada keadaan 

inputnya. Peralatan input dapat berupa sensor photo elektrik, push button pada 

panel kontrol, limit switch atau peralatan lainnya dimana dapat menghasilkan 

suatu sinyal yang dapat masuk ke dalam PLC. Peralatan output dapat berupa 

switch yang menyalakan lampu indikator, relay yang menggerakkan motor atau 

peralatan lain yang dapat digerakkan oleh sinyal output dari PLC. Selain itu PLC 

juga menggunakan memori yang dapat diprogram untuk menyimpan instruksi  

instruksi yang melaksanakan fungsi – fungsi khusus seperti : logika pewaktuan, 

sekuensial dan aritmetika yang dapat mengendalikan suatu mesin atau proses 

melalui modul – modul I/O baik analog maupun digital. 

CATU DAYA

PROGRAMMER / 

MONITOR

SAKLAR
MODUL

MASUKAN

MODUL

KELUARAN

MIKROPROSESSOR

MEMORI

 

Gambar 2.1 Sistem Layout dan Hubungan PLC 
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2.3 Kelebihan dan Kurangan Pemakaian PLC 

 Beberapa kelebihan pemakaian PLC dibandingkan dengan peralatan 

kontrol relay knvensional adalah : 

1) Fleksibel 

Pada peralatan konvensional, 1 buah mesin dikontrol dengan 1 buah alat 

pengendali, namun dengan PLC, pemakaian banyak mesin hanya dikontrol 

dengan 1 buah PLC saja. 

2) Deteksi dan koreksi peralatan lebih mudah 

Apabila program kontrol sudah dibuat dan dimasukkan kedalam PLC 

dengan cara memrogramnya, maka program dapat dengan mudah diubah 

dengan cepat, setelah itu program dapat dijalankan. Apabila masih terdapat 

kesalahan, maka dapat dikoreksi dengan menggunakan diagram ladder 

sehingga koreksi dapat segera dilakukan. 

3) Harga relative murah 

Perkembangan teknologi memungkinkan peningkatan fungsi, ukuran dan 

bentuk PLC yang semakin ringkas yang tentunya akan menurunkan harga 

pembuatan yang mahal. Salah satu fungsi yang terus ditingkatkan adalah 

modul input / output, sehingga saat ini banyak dijumpai PLC dengan jumlah 

masukan dan keluaran yang banyak dengan harga yang murah. 

4) Pengamatan visual 

Operasi PLC saat menjalankan program dapat dilihat dengan teliti pada 

monitor computer, sehingga dengan mudah dalam proses pencarian, 

pengamatan dan pembenahan program. Dengan demikian proses 

pembenahan hanya membutuhkan waktu yang singkat. 

5) Kecepatan operasi 

Kecepatan operasi PLC sangat cepat, kecepatan operasi ini adalah 

mengaktifkan fungsi-fungsi logika hanya dalam waktu beberapa milidetik. 

Hal ini karena PLC menggunakan rangkaian elektronik yang jika 

dibandingkan dengan penggunaan relay magnetic yang kecepatan 

operasinya lebih lambat. 
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6) Implementasi proyek lebih singkat 

7) PLC mengkonsumsi daya yang jauh lebih kecil dibandingkan system kontrol 

konvensional. 

8) Sederhana, mudah dalam penggunaannya dan mudah memodifikasi tanpa 

biaya tambahan. 

9) Dokumentasi lebih mudah 

Hasil pemrograman PLC dapat dicetak sehingga dapat dengan mudah dalam 

pencarian arsip gambar kontrol. 

 

Selain memiliki kelebihan, PLC juga memiliki kekurangan diantaranya 

yaitu bagi masyarakat umum, PLC masih tergolong teknologi baru sehingga 

dibutuhkan waktu untuk mengubah system konvensional yang sudah ada 

sebelumnya dan PLC sangat dipengaruhi oleh kondisi lingkungan yang ekstrim 

misalnya lingkungan panas yang tinggi, vibrasi yang sangat tidak cocok untuk 

penggunaan PLC karena dapat merusak PLC. 

2.4 Bagian Utama PLC 

 PLC sesungguhnya merupakan system mikrokontroler khusus industry, 

artinya seperangkat perangkat keras dan lunak yang diadaptasi untuk keperluan 

dalam dunia industri. 

CATU

DAYA

KOMUNIKASI

JALUR

TAMBAHAN

M
E

M
O

R
I

CPU

PENGATURAN

MASUKAN

PENGATURAN

KELUARAN

Terminal sekrup untuk jalur keluaran

Terminal sekrup untuk jalur masukan

Kontroler PLC

Komputer untuk pemrograman PLC

 

Gambar 2.2 Bagian-Bagian Utama PLC 
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Dalam Sistem PLC terdapat beberapa komponen bagian utama yaitu : 

2.4.1 Unit Pengolahan Pusat (CPU – Central Processing Unit) 

Unit Pengolah pusat CPU merupakan otak dari sebuah kontroler PLC. 

CPU ini juga menangani komunikasi dengan piranti eksternal, 

inerkonektivitas antar bagian-bagian internal PLC, eksekusi program, 

manajemen memori, mengawasi atau mengamati masukan dan memberikan 

sinyal keluaran (sesuai dengan proses atau program yang dijalankan). 

Kontroler PLC memiliki suatu rutin kompleks yang digunakan untuk 

memeriksa memori agar dapat memastikan memori PLC tidak rusak, hal ini 

dilakukan karena alasan keamanan. Hal ini bias dijumpai dengan adanya 

indicator lampu pada badan PLC sebagai indicator terjadinya kesalahan atau 

kerusakan. 

2.4.2 Memori 

Memori Sistem (saat ini banyak yang mengimplementasikan 

penggunan teknologi flash) digunakan oleh PLC untuk system kontrol 

proses. Selain berfungsi untuk menyimpan system operasi, juga digunakan 

untuk menyimpan program yang harus dijalankan, dalam bentuk biner, hasil 

terjemah diagram yang dibuat oleh pemrogram. Isi dari memori flash 

tersebut dapat diubah (bahkan dapat juga dikosongkan atau dihapus) jika 

memang dikehendaki seperti itu. Tetapi yang jelas, dengan penggunaan 

teknologi flash, proses penghapusan dan pengisian kembali memori dapat 

dilakukan dengan mudah dan cepat. 

2.4.3 Pemrograman PLC 

Kontroler PLC dapat deprogram melalui computer, tetapi juga bias 

deprogram melalui pemrograman manual, yang biasa disebut dengan konsol 

(console). Untuk keperluan ini dibutuhkan perangkat lunak, yang biasanya 

juga bergantung pada produk PLC-nya. 
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2.4.4 Catu Daya PLC 

Catu daya lisrik untuk memberikan pasokan catu daya ke seluruh 

bagian PLC(termasuk CPU, memori dan lain-lain). Kebanyakan PLC 

bekerja dengan catu daya 24 VDC atau 220 VAC. Beberapa PLC catu 

dayanya terpisah (sebagai modul tersendiri). Yang demikian biasanya 

merupakan PLC besar, sedangkan yang medium atau yang kecil, catu 

dayanya sudah menyatu. 

Catu daya listrik ini biasanya tidak digunakan untuk memberikan catu 

daya langsung ke masukan maupun keluaran, artinya masukan dankeluaran 

murni merupakan saklar (baik relai maupun opto-isolator). Pengguna harus 

menyediakan sendiri catu daya terpisah untuk masukan dan keluaran PLC. 

Hal ini bertujuan agar apabila terjadi kesalahan pemakaian maka tidak akan 

merusak PLC-nya itu sendiri karena memiliki catu daya terpisah antara PLC 

dengan jalur –jalur masukan dan keluaran. 

2.4.5 Masukan-masukan PLC 

Kecerdasan system terotomasi sangat bergantung pada kemampuan 

sebuah PLC untuk membaca sinyal dari berbagai macam jeis sensor dan 

piranti-piranti masukan lainnya. Untuk mendeteksi proses atau kondisi atau 

status suatu keadaan yang sedang terjadi, misalnya, berapa cacah barang 

yang sudah diproduksi, ketinggian permukaan air, tekanan udara dan lain 

sebagainya, maka dibutuhkan sensor-sensor yang tepat untuk masing-

masing kondisi atau keadaan yang akan dideteksi tersebut. Dengan kata lain, 

sinyal-sinyal masukan tersebut dapat berupa sinyal logic (ON atau OFF) 

maupun analog. 

2.4.6 Pengeluaran atau Antarmuka Masukan 

Antarmuka masukan berada diantara jalur masukan yang 

sesungguhnya dengan unit CPU. Tujuannya adalah melindungi CPU dari 

sinyal-sinyal yang tidak dikehendaki yang bias mersusak CPU itu sendiri. 
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Modul antarmuka masukan ini berfungsi untuk mengkonversi atau 

mengubah sinyal-sinyal masukan dari luar ke sinyal-sinyal yang sesuai 

dengan tegangan kerja CPU yang bersangkutan (misalnya, masukan dari 

sensor dengan tegangan kerja 24 VDC harus dikonversikan menjadi 

tegangan 5 VDC agar sesuai dengan tegangan kerja CPU). Hal ini dengan 

mudah bias dilakukan dengan menggunakan rangkaian opto-isolator 

sebagaimana ditunjukkan pada gambar dibawah ini. 

CPUMasukan

LED

Photo Transistor

i

 

Gambar 2.3 Rangkaian Antarmuka Masukan PLC 

Penggunaan opto-isolator artinya tidak ada hubungan kabel sama 

sekali antara dunia luar dengan unt CPU. Secara optic dipisahkan atau 

dengan kata lain, sinal ditransmisikan melalui cahaya. Kerjanya sederhana, 

piranti eksternal akan memberikan sinyal untuk menghidupkan LED (dalam 

opto-isolator), akibatnya photo transistor akan menerima cahaya dan akan 

menghantarkan arus (ON). Begitu juga sebalinya, saat sinyal masukan tidak 

ada lagi, maka LED akan mati dan photo transistor akan berhenti 

menghantar (OFF). 

2.4.7 Keluaran-keluaran PLC 

Sistem terotomasi tidaklah akan lengkap jika tidak ada fasilitas 

keluaran atau fasilitas untuk menghubungkan dengan alat-alat eksternal. 

Beberapa alat atau piranti yang banyak digunakan adalah motor, solenoid, 

relai, lampu indicator, speaker dan ain sebagainya. 
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2.4.8 Pengaturan atau Antarmuka Keluaran 

Sebagaimana pada antarmuka masukan, keluaran juga membutuhkan 

antarmuka yang sama yang digunakan untuk memberikan perlindungan 

antara CPU dengan peralatan eksternal, sebagaimana ditunjukan pada 

gambar dibawah. Cara kerjanya juga sama, yaitu menyalakan dan 

mematikan LED di dalam opto-isolator yang ada di CPU, sedangkan yang 

membaca status photo transistor, apakah menghantarkan arus atau tidak 

adalah peralatan atau piranti eksternal. 

KeluaranCPU

LED

Photo Transistor

i

 

Gambar 2.4 Rangkaian Antarmuka Keluaran PLC 

2.4.9 Jalur Ekstensi atau Tambahan 

Setiap PLC biasanya memiliki jumlah masukan dan keluaran yang 

terbatas. Jika diinginkan, jumlah ini dapat ditambahkan dengan 

menggunakan sebuah modul keluaran dan masukan tambahan (I/O 

expansion atau I/O extension module). 

2.5 Prinsip Kerja PLC 

 Pada dasarnya PLC menerima data-data masukan dari peralatan input luar 

seperti tombol tekan, saklar, sensor temperature, sensor tekanan, sensor level, 

sensor aliran dan sebagainya. Data-data masukan ini bisa berupa sinyal-sinyal 

digital. Kemudian oleh CPU PLC, sinyal digital tersebut akan diolah sesuai 

dengan program-program yang telah dibuat / disimpan dalam memori CPU. 

Selanjutnya CPU akan mengambil keputusan lalu dipindahkan kemodul output 

masih dalam bentuk sinya digital. Sinyal digital ini diproses untuk menggerakkan 
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peralatan output yang dapat berupa magnet, cahaya, panas, audio, motor, elektro 

kimia dan lain sebagainya. Peralatan output ini yang nantinya akan digunakan 

untuk mengoperasikan system atau proses yang akan dikontrol. 

2.6 PLC OMRON CPM1A 

 Programmable Logic Controller (PLC) Omron CPM1A merupakan produk 

dari Omron. PLC ini mempunyai indikator terminal input dan terminal output 

(I/O) dengan perbandingan jumlah terminal sebesr 60% adalah terminal input dan 

40% merupakan terminal output.  

 Selain indikator terminal I/O terdapat juga empat buah lampu indicator 

yaitu PWR, RUN, ERR/ALM dan COMM. Fungsi dan arti dari keempat lampu 

indikator tersebut dapat dijelaskan pada table 2.1 berikut ini. 

Tabel 2.1 Arti Lampu Indikator PLC OMRON CPM1A 

Indikator Status Keterangan 

PWR 

(hijau) 

ON Catu daya disalurkan ke PLC 

OFF Catu daya tidak disalurkan ke PLC 

RUN 

(hijau) 

ON PLC dalam mode kerja RUN atau MONITOR 

OFF PLC dalam kondisi mode PROGRAM atau 

munculnya kesalahan yang fatal 

COMM 

(kuning) 

Kedip Data sedang dikirim melalui port peripheral 

atau RS-232C 

OFF Tidak ada proses pengiriman data melalui port 

peripheral maupun RS-232C 

ERR/ALM 

(merah) 

ON Adanya suatu kesalahan fatal operasi PLC 

berhenti 

Kedip Adanya suatu kesalahan tak fatal operasi PLC 

berlanjut 

OFF Operasi berjalan dengan normal 

 



  Politeknik Negeri Sriwijaya  16  

 

 

 

Gambar 2.5 PLC OMRON CPM1A 

Selain empat buah lampu indicator tersebut, tersebut juga terdapat fasilitas 

terminal untuk melkukan hubungan komunikasi dengan computer melalui RS-

232C atau yang lebih dikenal dengan port serial. 

2.7 Mode Kerja 

 PLC Omron CPM1A dapat bekerja dalam tiga mode yaitu : Program, 

Monitor dan RUN. Namun hanya satu mode kerja saja yang bisa aktif pada saat 

yang bersamaan. 

2.7.1 Mode Program 

Mode ini digunakan untuk melakukan beberapa operasi dalam 

persiapan eksekusi program : 

1) Mengubah parameter-parameter inisial /  operasi sebagaimana terdapat di 

dalam setup PC. 

2) Menulis, menyalin atau memeriksa program. 
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3) Memeriksa pengkabelan dengan cara memaksa bit-bit I/O ke kondisi set 

atau reset. 

2.7.2 Mode Monitor 

Program atau diagram tangga berjalan dalam mode Monitor ini dn 

beberapa operasi dapat dilakukan melalui sebuah Piranti Pemrograman. 

Secara umum, mode Monitor digunakan untuk melkukan pelacakan kesalahan 

(debug atau troubleshooting), operasi pengujian dan melakukan penyesuaian 

(adjustment) : 

1) Pengeditan on-line (langsung). 

2) Mengawasi memori I/O selama PLC beroperasi. 

3) Memaksa set atau reset bit-bit I/O, mengubah nilai-nilai dan mengubah 

nilai saat ini selama PLC beroperasi. 

2.7.3 Mode RUN 

Program atau diagram tangga dijalankan denga kecepatan normal pada 

mode RUN ini. Operasi-operasi seperti pengendalian on-line, memaksa set 

atau reset bit-bit I/O dan mengubah nilai-nilai tidak dapat dilakukan dalam 

mode ini, tetapi status dari bit I/O dapat diwasi. 

2.8 Bahasa Program PLC Omron CPM1A 

 Pembuatan bahasa program PLC Omron CPM1A dengan menggunakan 

bantuan computer yang telah dilengkapi dengan perangkat lunak CX Programmer 

V 9.0. Pemrograman dilakukan dengan membuat ladder diagramnya (diagram 

tangga). Apabila diinginkan ladder diagram yang sudah dibuat dapat secara 

otomatis dikonversikan kebentuk kode mnemonik ataupun ke dalam bentuk 

diagram blok (function plan). 

2.8.1 Ladder Diagram 

Contoh bentuk ladder diagram sebagai berikut : 
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END (01)

000.00

000.01

010.00

000.02 000.03 010.00

 

Gambar 2.6 Contoh Bentuk Ladder Diagram 

2.8.2 Diagram Blok (Function Plan) 

Contoh bentuk diagram blok : 

000.00

000.01

010.00

000.02

000.03

010.00

&>=

END (01) End

 

Gambar 2.7 Contoh Bentuk Diagram Blok (Function Plan) 

2.8.3 Kode Mnomonik (Statement List) 

Contoh Kode Mnemonik sebagai berikut : 

Alamat Instruksi Data 

00000 LD 00000 

00001 OR 00001 

00002 OR 01000 

00003 ANDNOT 00002 

00004 ANDNOT 00003 
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00005 OUT 01000 

00006 END  

 

Gambar 2.8 Contoh bentuk Kode Mnomonik 

2.9 Instruksi Dasar Pemrograman 

2.9.1 Instruksi-instruksi Tangga 

Instruksi tangga (ladder instruction) adalah instruksi-instruksi yang 

terkait dengan kondisi-kondisi di dalam diagram tangga, baik itu yang berdiri 

sendiri maupun kombinasi atau gabungan dengan blok instruksi berikut atau 

sebelumnya yang akan membentuk suatu kondisi eksekusi. Beberapa instruksi 

tangga diantaranya : 

1) LOAD (LD) LOAD NOT (LD NOT) 

Kondisi pertama yang mengawali sembarang blok logika di dalam 

diagram tangga berkaitan dengan instruksi LOAD atau LOAD NOT. 

Masing-masing instruksi ini membutuhkan satu baris kode mnemonik. 

00000

00000

Instruksi LOAD

Instruksi LOAD NOT

 

 

 

Gambar 2.9 Contoh Instruksi LD Dan LD NOT 

 

2) AND dan AND NOT 

Jika terdapat dua atau lebih kondisi yang dihubungkan secara seri pada 

garis instruksi yang sama, maka kondisi yang pertama menggunakan 

Alamat Instruksi Data 

00000 LD 00000 

00001 Instruksi  

00002 LD NOT 00000 

00003 Instruksi  
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instruksi LD atau LD NOT dan sisanya menggunakan instruksi AND dan 

AND NOT. 

00000

Instruksi

00100  LR 0000

 

 

 

 

 

 

Gambar 2.10 Contoh Instruksi AND Dan AND NOT 

3) OR dan OR NOT 

Jika dua atau lebih kondisi dihubungkan secara pararel, artinya dalam 

garis instruksi yang sama, maka konsisi pertama terkait dengan instruksi 

LD atau LD NOT dan sisanya berkaitan dengan instruksi OR atau OR 

NOT. 

00000

00100

LR 0000

Instruksi

 

 

 

 

 

 

 

 

Gambar 2.11 Contoh Instruksi OR dan OR NOT 

 

Alamat Instruksi Data 

00000 LD 00000 

00001 AND NOT 00100 

00002 AND LR 0000 

00003 Instruksi  

Alamat Instruksi Data 

00000 LD NOT 00000 

00001 OR NOT 00100 

00002 OR LR 0000 

00003 Instruksi  



  Politeknik Negeri Sriwijaya  21  

 

 

4) Kombinasi instruksi AND dan OR 

Jika instruksi AND dan OR digabung atau dikombinasikan dalam suatu 

diagram tangga yang lebih kompleks, maka bisa dipandang satu persatu, 

artinya bisa dilihat masing-masing hasil gabungan dua kondisi 

menggunakan instruksi AND atau OR secara sendiri-sendiri kemudian 

menggabungkannya menjadi satu kondisi menggunakan instruksi AND 

atau OR yang terakhir. 

00000

00200

Instruksi

00001 00002 00003

 

 

 

 

 

 

 

Gambar 2.12 Contoh Kombinasi AND Dan OR 

 

5) Instruksi OUTPUT dan OUTPUT NOT 

Cara yang paling mudah untuk mengeluarkan hasil kombinasi kondisi 

eksekusi adalah dengan menyambung langsung dengan keluaran melalui 

instruksi OUTPUT atau OUTPUT NOT. 

 

00000

00001

01000

01001

 

 

Alamat Instruksi Data 

00000 LD 00000 

00001 AND 00001 

00002 OR 00200 

00003 AND 00002 

00004 ANDNOT 00003 

00005 Instruksi  
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Alamat Instruksi Data 

00000 LD 00000 

00001 OUT 00001 

 

Gambar 2.13 Contoh Instruksi OUTPUT dan OUTPUT NOT 

 

6) Instruksi END 

Instruksi terakhir yang harus dituliskan atau digambarkan dalam diagram 

tangga adalah instruksi END. CPU pada PLC akan mengerjakan semua 

instruksi dalam program dari awal (baris pertama) hingga ditemui 

instruksi END yang pertama, sebelum kembali lagi mengerjakan instruksi 

dalam program dari awal lagi, artinya instruksi-instruksi yang ada di 

bawah atau setelah instruksi END akan diabaikan. Angka yang 

bertuliskan pada instruksi END pada kode mnemonik merupakan kode 

fungsinya. Hal yang perlu diperhatikan di sini adalah ketentuan penulisan 

instruksi END, jika suatu diagram tangga atau program PLC tidak 

dilengkapi instruksi END, maka program tidak akan dijalankan sama 

sekali. 

00000

END (01)

Instruksi

00001

Eksekusi program 

berakhir disini !

 

 

 

 

 

 

 

Gambar 2.14 Contoh Instruksi END 

Alamat Instruksi Data 

00000 LD 00001 

00001 OUT NOT 01001 

Alamat Instruksi Data 

00500 LD 00000 

00501 AND NOT 00100 

00502 Instruksi  

00503 END(01)  
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2.9.2 Instruksi-Instruksi Blok Logika 

Instruksi-instruksi blok logika menyatakan hubungan antar blok blok 

logika, misalnya instruksi AND LD akan meng-AND-logika-kan kondisi 

eksekusi yang dihasilkan oleh dua blok logika, demikian juga dengan 

instruksi OR LD untuk meng-OR-logika-kan kondisi eksekusi yang 

dihasilkan dua blok logika. 

1) AND LOAD (AND LD) 

Contoh kondisi network yang sederhana tetapi diagram tangga tersebut 

membutuhkan sebuah instruksi blok logika AND LD. 

 

00000

00001

Instruksi

00002

00003

 

 

Alamat Instruksi Data 

00000 LD 00000 

00001 OR 00001 

00002 LD 00002 

00003 OR NOT 00003 

00004 AND LD - 

 

Gambar 2.15 Contoh Instruksi Logika AND LD 

 

2) OR LOAD (OR LD) 

Instruksi ini digunakan untuk meng-OR-logika-kan dua blok logika. 

Contoh diagram tangga yang membutuhkan instruksi OR LD untuk 

menggabungkan blok logika atas bawah. 
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00000

00002

Instruksi

00001

00003

 

Alamat Instruksi Data 

00000 LD 00000 

00001 AND NOT 00001 

00002 LD 00002 

00003 AND 00003 

00004 OR LD - 

 

Gambar 2.16 Contoh Instruksi Logika OR 

 

3) Instruksi-instruksi blok logika dalam seri 

Untuk mengkodekan diagram dengan kondisi logika yang dipasang atau 

dihubungkan secara seri, sebagaimana ditunjukan pada gambar diagram 

tangga dibawah maka diagram perlu dibagi-bagi menjadi blok-blok logika 

yang bersangkutan. Masing-masing blok dikodekan menggunakan 

instruksi LD atau LD NOT untuk kondisi pertama, selanjutnya cara 

menggabungkan dengan blok-blok logika lainnya ada 2 (dua) cara seperti 

yang terdapat pada table kode mnemoniknya. 

 

00000

00001

00002

00003

00004

00005

20000
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Gambar 2.17 Contoh Blok Logika Yang Dihubungkan Secara Serial 

00000

00002

00004

00001

00003

00005

20001

 

 

 

 

 

 

 

 

 

 

 

 

G

Gambar 2.18 Contoh Blok Logika Yang Dihubungkan Secara Pararel 

Alamat Instruksi Data 

00000 LD 00000 

00001 OR NOT 00001 

00002 LD NOT 00002 

00003 OR 00003 

00004 AND LD - 

00005 LD 00004 

00006 OR 00005 

00007 AND LD - 

00008 OUT 20000 

Alamat Instruksi Data 

00000 LD 00000 

00001 OR NOT 00001 

00002 LD NOT 00002 

00003 OR 00003 

00004 AND LD - 

00005 LD 00004 

00006 OR 00005 

00007 AND LD - 

00008 OUT 20000 

Alamat Instruksi Data 

00000 LD 00000 

00001 AND NOT 00001 

00002 LD NOT 00002 

00003 AND NOT 00003 

00004 OR LD - 

00005 LD 00004 

00006 AND 00005 

00007 OR LD - 

00008 OUT 20001 

Alamat Instruksi Data 

00000 LD 00000 

00001 AND NOT 00001 

00002 LD NOT 00002 

00003 AND NOT 00003 

00004 LD 00004 

00005 AND 00005 

00006 OR LD - 

00007 OR LD - 

00008 OUT 20001 
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4) Mengkombinasikan AND LD dan OR LD 

Pada gambar dibawah ini ditunjukan sebuah diagram tangga yang hanya 

mengandung dua blok logika saja. Blok b tidak perlu dibagi lagi, karena 

bisa dikodekan langsung menggunakan AND dan OR. 

Pada gambar dibawah ini ditunjukan diagram tangga lainnya, walaupun 

sama dengan gambar diagram tangga sebelumnya, tetapi blok B pada 

diagram tangga gambar diatas tidak dapat dikodekan tanpa memisahkan 

menjadi dua blok logika (karena ada dua kondisi pada garis kedua). 

 

00001

00201

00004

20001

Block

A

Block

B

00000 00002 00003

 

 

Alamat Instruksi Data 

00000 LD 00000 

00001 AND NOT 00001 

00002 LD 00002 

00003 AND 00003 

00004 OR 00201 

00005 OR 00004 

00006 AND LD - 

00007 OUT 20001 

 

Gambar 2.19 Mengkombinasi AND LD Dan OR LD 

Pada gambar dibawah ini ditunjukkan diagram tangga lainnya, walaupun 

sama dengan gambar diagram tangga sebelumnya, tetapi Blok B pada 



  Politeknik Negeri Sriwijaya  27  

 

 

diagram tangga gambar diatas tidak dapat dikodekan tanpa memisahkan 

menjadi dua blok logika (karena ada dua kondisi pada garis kedua). 

00001

00202

2000200000 00002 00003

00004

Block

B1

Block

B2

Block

A

Block

B  

Alamat Instruksi Data 

00000 LD NOT 00000 

00001 AND 00001 

00002 LD 00002 

00003 AND NOT 00003 

00004 LD NOT 00004 

00005 AND 00200 

00006 OR LD - 

00007 AND LD - 

00008 OUT 20002 

 

Gambar 2.20 Contoh Lain Mengkombinasi AND LD Dan OR LD 

2.9.3 Timer 

Instruksi TIM (timer) dapat digunakan sebagai pewaktu delay ON/OFF 

delayjuga sebagai rangkaian relay. Sebenarnya instruksi TIM adalah instruksi 

pengurangan dari pewaktu yang membutuhkan nomor dari timer mulai 0 

hingga nomor 127 dan nilai set (SV) yang berkisar dari 6000 sampai 9999 

atau jika dikonversi ke dalam detik dibagi 10 sehingga dapat membentuk 

timer 0 sampai 999,9 detik. 
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TIM N

SV

N : Nomor timer #000 hingga127

SV : Set Value [Word atau BCD #0 s/d 9999]

   IR,SR,AR,DM,HR,LR, #

 

     (a) 

00000

TIM 000

TIM 000

TIM 000
5.0

detik

00001

END

 

 

 

      (b) 

Input

00000

Output

01000

Output

01001

5.0

detik

 

      (c) 

Gambar 2.21 (a) Format Instruksi Timer ; (b) Contoh Ladder Diagram Dan 

Mnomonik Pemakaian Timer On Delay ; (c) Timing Diagram 

2.9.4 Instruksi Relay (IR) 

Fungsi dari internal relay (IR) dalam bahasa program PLC adalah untuk 

menghindarkan kontak output PLC bekerja pada kontak arus  maksimum. 

Dengan menggunakan internal relay yang ada dalam CPU PLC akan lebih 

memungkinkan penggunaan kode output PLC lebih efisien. Pada PLC jenis 

Alamat Instruksi Data 

00000 LD 00000 

00001 AND NOT 00001 

00002 TIM 000 

  #0050 

00004 LD TIM 000 

00005 OUT 01000 

00006 LD NOT TIM 000 

00007 OUT 01001 

00008 END(01)  



  Politeknik Negeri Sriwijaya  29  

 

 

Omron tipe CPM1A penomoran internal relay (IR) adalah mulai dari 20000 

s/d 20324. 

000.00

200.00

END (01)

000.01 200.00

200.00 010.00

INTERNAL RELAY K1

KONTAKTOR UTAMA

End

S1

IR-0

S2 IR-0

K1IR-0

 

Gambar 2.22 Contoh Pemakaian Internal Relay 

2.10 Kode Input dan Kode Output 

 Pada PLC Omron CPM1A pengkodean peralatan input dan peralatan 

output dilakukan sebagai berikut : 

2.10.1 Peralatan Input 

Pengkodeannya sebagai berikut : 

1) Kode 000xx dimana 000 adalah kode input dan xx adalah nomor input 

(00000 s/d 00011) 

2) Kode 001xx dimana 001 adalah kode input dan xx adalah nomor input 

(00100 s/d 00105) 

2.10.2 Peralatan Output 

Pengkodeannya sebagai berikut : 

1) Kode 010xx dimana 010 adalah kode output dan xx adalah nomor output 

(01000 s/d 01007) 

2) Kode 011xx dimana 011 adalah kode output dan xx adalah nomor output 

(01100 s/d 01103) 
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Tabel 2.2 Pengkodean Terminal I/O 

Jumlah 

Terminal 

I/O pada 

CPU 

Terminal CPU Terminal satuan 

ekspansi I/O 

Catu 

Daya 

Nomor 

Model 

Input Output Input Output 

10 6 point : 

00000 ke 

00005 

4 point : 

01000 ke 

01003 

12 point : 

00100 ke 

00111 

8 point : 

01100 ke 

01107 

AC CPM1-

10CDR-A 

DC CPM1-

10CDR-D 

20 12 point : 

00000 ke 

00011 

8 point : 

01000 ke 

01003 

12 point : 

00100 ke 

00111 

8 point : 

01100 ke 

01107 

AC CPM1-

20CDR-A 

DC CPM1-

20CDR-D 

30 18 point : 

00000 ke 

00011 

00100 ke 

00105 

12 point : 

01000 ke 

01007 

01100 ke 

01103 

12 point : 

00200 ke 

00211 

8 point : 

01200 ke 

01207 

AC CPM1-

30CDR-A 

DC CPM1-

30CDR-D 

 

2.11 Pemrograman PLC OMRON CPM1A Dengan Komputer 

 Pemrograman PLC merupakan proses pemasukan data kedalam CPU PLC. 

Pemrograman bahasa program dilakukan dengan menggunakan computer yang 

sudah diinstall dengan perangkat lunak (software) CX Programmer V 9.0. 

 Dengan menggunakan komputer maka pengisisan dan penyusunan 

program PLC akan lebih menjadi mudah dan praktis. Selainuntuk mendownload 

program PLC, running dan monitor operasi kerja PLC juga dapat dilakukan 

melalui computer. 

 Komputer yang telah dilengkapi program CX Programmer v 9.0, maka 

dapat dilakukan : 
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1) Membuat program baru 

2) Penyimpanan program dan editing 

3) Upload dan download program antar PLC dan komputer 

4) Status program saat dijalankan 

5) Menulis komentar pada program untuk memudahkan pembacaan program 

6) Print Out program dikertas untuk dokumentasi 

SERIAL RS 232C

ADAPTOR 232 CIFO

PLC

Output

Input

 

Gambar 2.23 Konfigurasi PLC Download Program Dari Komputer 

2.11.1 Peralatan interface 

Yang dibutuhkan : 

1) Software OMRON CX Programmer V 9.0 diinstall pada PC yang 

mempunyai fasilitas windows 

2) Kabel Serial RS 232 C untuk menghubungkan antara computer dengan 

adaftor CIFO 232 

3) Adaftor CIFO 232 type NT bila satu buah PLC dihubungkan dengan satu 

buah PC dan tipe HOST bila satu buah PC dihubungkan dengan banyak 

PLC 
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2.11.2 Membuat Diagram Tangga 

Jalankan CX Programmer V 9.0 sehingga akan dimunculkan jendela 

penyuntingan diagram tangga sebagaimana ditunjukkan pada gambar 2.24. 

Pada bagian disebelah bawah kanan berisikan komponen-komponen atau 

kondisi-kondisi diagram tangga. Sedangkan bagian atas digunakan untuk 

manajemen berkas (simpan, baca dan lain-lain), manajemen tangga serta 

sarana komunikasi (dengan PLC).  

 

Gambar 2.24 Tampilan Penyuntingan Diagram Tangga CX Programmer 

V 9.0 

Untuk membuat diagram tangga yang baru mulailah dengan Menu File 

→ New atau dengan menggunakan key Ctrl+N, sehingga akan dimunculkan 

kotak dialog sebagaimana ditunjukan pada gambar 2.25. Lakukan pengaturan 

sebagaiman ditunjukkan pada gambar 2.25. Kemudian Klik Ok. Sekarang 

penggambaran diagram tangga sudah dapat dilakukan.  
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Gambar 2.25 Tampilan Lembar Kerja Baru 

Untuk memulai menggambar diagram tangga bisa dilakukan dengan 

memilih fungsi atau kondisi apa yang akan dipasang, misalnya dipilih 

Normally open contact yang akan dipasang pertama, klik pada tombol kondisi 

tersebut, atau bisa dengan menggunakan keypad C lalu tempatkan pada garis 

instruksi, kemudian isikan alamatnya pada kotak dialog yang muncul seperti 

ditunjukkan pada gambar 2.26. Alamat ini memiliki dua bagian, yang pertama 

merujuk pada alamat word, sedangkan yang keduan erujuk pada alamat bit 

yang terkait (keduanya dipisahkan dengan tanda titik). Isikan sesuai dengan 

kode peralatan I/O yang telah ditetapkan.  

 

Gambar 2.26 Kotak Dialog Contact 

Setelah mengisikan alamat pada kotak dialog tersebut, maka akan 

ditampilkan lambang kondisi normally open contact pada diagram tangga 
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sebagaimana contohnya ditunjukkan pada gambar 2.27. Terlihat bahwa 

alamat yang telah dituliskan ditampilkan di atas symbol tersebut. 

 

Gambar 2.27 Penggambaran Normally Open Contact 

Kemudian dilajutkan dengan memilih kondisi untuk keluaran yaitu 

Normally OFF output. Tempatkan di sisi kanan dari Normally open contact 

yang sudah digambar sebelumnya dan isikan alamatnya sesuai dengan kode 

peralatan I/O yang telah ditentukan seperti gambar 2.28. 

Untuk menyisipkan network baru, maka pilih menu Insert→Rung maka 

akan tampil dua pilihan yaitu Above (Shift+R) dan Below (R). Above 

digunakan untuk mnyisipkan network diatas network yang sedang disorot 

pada saat itu, sedangkan Below digunakan untuk menyisipkan network 

dibawah network yang sedang di sorot.  



  Politeknik Negeri Sriwijaya  35  

 

 

 

Gambar 2.28 Hasil Sementara Diagram Tangga 

Untuk menutup program harus diakhiri dengan fungsi END, untuk 

melakukan hal ini, fungsi END harus ditempatkan di bawah jaringan atau 

network yang telah digambar sebelumnya. Untuk menempatkan fungsi ini, 

klik pada toolbar New PLC instruction atau bisa juga dengan keypad (I), 

sehingga akan ditampilkan kotak dialog seperti gambar 2.29. 

 

Gambar 2.29 Kotak Dialog Fungsi END 

Pada kotak dialog New Instruction tuliskan fungsi END atau dengan 

mengklik Detail sehingga akan ditampilkan daftar seluruh fungsi yang 

tersedia untuk PLC yang bersangkutan, tampilannya ditunjukkan pada 

gambar 2.30. 
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Pada kotak  dialog tersebut pilih kelompok Find Instruction → END 

(01) → OK. Selanjutnya hasil akhir diagram dari diagram tangga ditunjukkan 

pada gambar 2.31.  

 

Gambar 2.30 Kotak Dialog Find Instruction 

 

Gambar 2.31 Hasil Akhir Diagram Tangga 
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2.11.3 Menyimpan Diagram Tangga 

Untuk menyimpan diagram tangga dilakukan dengan memilih menu 

File → Save Project. 

2.11.4 Pengaturan Komunikasi PLC Dengan Komputer 

Selanjutnya adalah mengatur komunikasi serial dengan PLC melalui 

menu Tool→Network Setting, ketika windows  PLC Network Configuration 

tampil klik Project→Scan Serial Port For PLCs lalu lakukan pengaturan 

sebagaimana ditunjukkan pada gambar 2.32. Pilih dimana PLC dihubungkan 

ke COM1 atau COM2 pada pilihan available port, juga pilihan kecepatan 

transfer data pada baud, serta tipe kabel yang dipakai lalu klik Next. Jika 

semua sudah lancar, maka bisa dilakukan komunikasi antara Komputer 

dengan PLC lebih lanjut. 

 

Gambar 2.32 Kotak Dialog Komunikasi Komputer Dengan PLC 

2.11.5 Transfer Program Dari Komputer Ke PLC 

Selanjutnya adalah mentransfer program dari computer ke PLC 

pertama klik tool Work Online atau bisa juga dengan menekan keypad 

Ctrl+w setelah itu langkah selanjutnya adalah melalui menu PLC → Transfer 

→ To PLC atau juga bisa langsung dengan menggunakan keypad Ctrl+T 

setelah proses download dari komputer  ke PLC selesai lalu klik Ok. 

Pengaturannya dapat dilihat pada gambar 2.33. 
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Gambar 2.33 Pengaturan Transfer Program Dari Komputer Ke PLC 

2.12 Menghubungkan PLC Dengan Peralatan Input dan Peralatan Output 

 Untuk pemakaian output beban, output dari PLC tidak diperbolehkan 

berhubungan langsung untuk menggerakkan kontaktor beban tetapi harus 

memakai kontaktor buffer terlebih dahulu. (Pada gambar dibawah dimisalkan K1 

adalah kontaktor buffer dan K2 adalah kontaktor beban). Hal ini karena 

keterbatasan PLC untuk menggerakkan kontaktor beban. 

S1
S2
S3
S4

K1

K2

F

Modul

Input

Modul

Output
CPU

M

K1

 

Gambar 2.34 Hubungan PLC Dengan Peralatan Input Dan Output 


